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1. Getting Started.

 

Welcome to Fonix® Embedded Builder 2.1. Fonix Embedded Builder gives you the ability to add Automatic Speech Recognition (ASR) and Text-To-Speech (TTS) technology to existing applications. This section will provide an overview of this help file.

 

a) Main Sections

In order to save time, please read the main sections of the manual before you begin developing applications with the Fonix Embedded Builder. Below, you will find links to the basic documentation, as well as a short description of each section, which will help you find the information you need.

 

For more information, see your platform-specific documentation.

 

 1 Create a Project

 

In Building Project section, you will find step-by-step instructions on how to create, build, and simulate a project in the Fonix Embedded Builder.

 

 2 Name a Node
 

To name or rename a node, see Naming Nodes section.

 

 3 Description of Fonix Embedded Speech SDK Technology
 

See Automatic Speech Recognition and Text-To-Speech sections in the Glossary of terms for details about the main technologies that make up Fonix Embedded Speech SDK.

 

 4 Fonix Embedded Speech SDK APIs
 

The information about each function in the three sets of Embedded APIs has been carefully documented. The three sets of APIs are as follows:
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    Fonix ASR core APIs
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    Fonix audio in APIs
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    Fonix audio out APIs
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    Letter-to-word ASR APIs
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    Speaker-dependent ASR APIs 

[image: image6.png]


    Multi-voice TTS APIs

 

 5 Examples 
 

To access sample projects, see Examples section.
 

 

6. Glossary

 

To examine a list of terms and their definitions, see the Glossary section.

 

b) Project Workspace

 As you begin, the program will display the Introduction section, and then bring up the project workspace. When you are in the project workspace, you can view a brief description of an icon, node, or node connection by pointing to it. A Tool_Tip will pop up in a small text box.
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Figure: The project workspace

2. Product Description.
Fonix Embedded Speech SDK 2.0 gives you the ability to add Automatic Speech Recognition (ASR) and Text-To-Speech (TTS) technology to existing applications. Fonix Embedded Speech SDK includes three major components: an Integrated Development Environment (IDE) called the Fonix Embedded Builder, the ASR APIs, and the TTS APIs. 

 

a) The Fonix Embedded Builder

The Fonix Embedded Builder provides a Microsoft Windows® -based GUI that executes on the PC and creates binaries that can execute on DSP (digital signal processor) platforms. The Windows interface simplifies testing and shortens development time. With the Fonix Embedded Builder, you can prototype and optimize before you generate application code. The binary files output by the Fonix Embedded Builder are used to add TTS and ASR functionality, allowing you to easily create speech applications.

 

 Builder output
 

The Builder output contains four components: TTS content, ASR content, engine runtime parameters, and functional flow information. The content file instructs the TTS and ASR engines in both input and output functionality. The functional flow information is used for running demos and applications that were prototyped in the Builder without having to write additional code.

 

b) Engines

Fonix provides engines as a 'C' library that is precompiled for many different DSPs, microcontrollers, and RISC CPUs. This library includes support for TTS, ASR, and audio. By combining the platform-specific library, which consists of a simple API, your custom code, and the speech content file, you can create a complete application. 

  

Operating systems
 

Fonix engines can run with or without operating systems. In addition to this, the audio is designed to run single or multi-threaded. The audio driver is set to get adequate CPU time to collect the samples at the correct sample rate. Interrupts, threads, and other events should not affect the recognition system.

 

Fonix provides libraries specific to platforms, operating systems, and compilers.

 

The Fonix Embedded Speech SDK engines are compiled to run on platforms that support file and fileless systems. Fonix engines do not require file access on DSPs. In these cases, all support is compiled into the executable. On platforms with file systems, the executable accesses the support files directly.

 
c) DSP speech development

The process for DSP speech development can be summarized in four main steps:

 

1 Prototype your application in the Fonix Embedded Builder and build the speech content file.

2 Write or use the Fonix audio drivers for the platform.

3 Add the Fonix APIs to the application.

4 Link the Fonix libraries and the speech content file to the application.

 
By following these steps, you can use Fonix Embedded Speech SDK to create applications with Fonix Automatic Speech Recognition and Text-To-Speech technology.


3. Building a Project.
Within this section, you will find step-by-step instructions on how to create, build, and simulate a project in the Fonix Embedded Builder.

 

a) Creating a project

Before you follow these instructions, it may be helpful to become familiar with the Node Palette section.
 

	Placing nodes

 

1 Click the Beginning Node icon in the Node Palette, then click in the project workspace to place a Beginning Node. You may also drag from the Node Palette to the workspace to place a node.

2 Repeat step 1 using the WordSpotter Node and the Ending Node.
 

Linking nodes

 

3 Connect the nodes by clicking a bottom connector [image: image8.png]


 and without releasing the mouse button, drag the mouse pointer to a top connector. [image: image9.png]



4 Click the link [image: image10.png]


 between WordSpot1 and End1. When the link is selected, it will appear colored instead of black. 

5 Adjust the link between the end of WordSpot1 and the beginning of WordSpot1 by clicking a point on the link and without releasing the mouse button, drag the pointer until the link bends around WordSpot1, then release the mouse button. You may put multiple bends in a link. See Editing Links section for more help with creating and editing connections.
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b) Assigning actions

You can assign actions to nodes with the Nodes tab.

 

1 In the Node Palette, click the Beginning Node, then click the Node Wizard to make the window active.

 

2 From the Exit command using recognition drop-down menu, select FnxPlayWave and type Sound528 inside the parentheses.

 

3 Select the WordSpotter Node, and then click the Node Wizard to make the window active. 

 

4 Click the Prompt field and type Say quit.

 

5 Next, click the Error Message field and replace the default error message with “You did not say quit”.

 

6 Click the link that goes to the Ending Node. The Links tab should now be visible. In the Node Wizard, click on the empty line below Recognition Words. You will have a cursor where you can type a recognition word.

 

7 Type “quit.” to the right of the word, below Phonemes, you will see the phonemes of the recognition word you typed (in this case, quit).
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8. Select the link that goes to from the bottom of the WordSpotter Node to the top of the WordSpotter Node. In the Node Wizard, on separate lines for each word, type what, repeat, and again.

 

9 Select the Ending Node to make the Node Wizard active. In the Entry command drop down menu, select execute() and type splash.exe inside the parentheses.

 

10 Next, click the WordSpotter Node, then make the Node Wizard active. Click the play button to the right of the Prompt label [image: image13.png]


 to hear the Prompt. To hear the error message, click the play button to the right of the Error Message label. If you did not get sound output, make sure the speakers are functioning properly.

 

11 Select the Ending Node and apply a message to it. Click the Prompt field on the Node Wizard and type “bye”. Try the play button again.

 

12 Save the project by clicking File menu, then Save. Type “Example1” as the file name, then click Save.

 

c) Building the project

The following steps will teach you how to build the project that you have created. This section assumes that you have previously assigned action using the Node Wizard.

 

1 Click the Build icon in the Toolbar section[image: image14.png]


. 

 

2 A default dialog box will prompt you to save before building. You can change this default in the Project Setting section dialog accessed through the Project menu. For more information on building your project, see Build Menu section.

 

d) Simulate the project

To simulate the project, click the Go icon [image: image15.png]


 or select Build from the Menu bar and then click Go.

 

	[image: image16.png]


 
	See Speech Detection to learn more about the window that pops up while the project is simulating.


 

e) Example files

After completing this sample project, you may want to look at an additional sample projects. See Examples for more information.


1. Menu bar.

The Menu bar provides access to a great deal of functionality in the Fonix Embedded Builder. Click a menu item in the figure below to link to the corresponding description.
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2. File menu.

In the figure below, click a menu item to jump to the corresponding description. If you prefer, read through the entire section to learn about each feature available from File.
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a) New
 

Select New to create a new project.

 

 b) Open
 

Select Open to retrieve an existing project. A dialog box will appear allowing you to browse for an existing project. Builder project files have an .fcb extension.

  

c) Close
 

Select Close to close the current project. If changes have been made to the current project after your last save, you will be prompted to save your changes.

  

d) Save
 

Select Save to retain the changes you have made to the current project. This option will only be enabled when a change has been made.

 

 

e) Save As
 

Select Save As to save the current project with a new filename and location. A dialog box will appear allowing you to enter the new name and destination.

 

 f) Print
 

Select Print in order to print the project workspace. A dialog box appears allowing you to set printer properties and control which pages to print, how many copies to make, and whether to send the project to the printer or to a file.

 

 g) Print Preview
 

Select Print Preview to see how the project will look when printed.

 

 h) Print Setup
 

Select Print Setup to set up printer options.

 

 i) Recent Files
 

Recent Files lists previously opened projects which you can open by selecting them.

  

j) Exit
 

Select Exit to close the application. You will be prompted to save open projects if you have made changes.


3. Edit menu.

In the figure below, click a menu item to jump to the corresponding description. If you prefer, read through the entire section to learn about each feature available from Edit.
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a) Cut
 

Select Cut to remove a selected node from the project workspace and save it to the clipboard.

 

 

b) Copy
 

Select Copy to duplicate a selected node from the project workspace and save it to the clipboard.

  

c) Paste
 

 Select Paste to insert the contents of the clipboard to the project workspace.

  

d) Delete
 

Select Delete to remove the selection, including nodes and links, from the project.

 

 e) Straighten
 

Straighten is only enabled when a node link is highlighted. Select Straighten to straighten the selected node link. 


4. View menu.
In the figure below, click a menu item to jump to the corresponding description. If you prefer, read through the entire section to learn about each feature available from View. 
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 a) Introduction On Startup
 

Select Introduction On STarup, to cause the introduction screen and accompanying audio file to play when the program begins.

  

b) Toolbar
 

Selected Toolbar to display the Toolbar at the top of the project workspace.

 

 c) Status Bar
 

Select Status Bar to display a status window at the bottom of the project workspace. The status window contains information such as whether number lock is on or off.

 

 d) Node Palette
 

Select Node Palette to display the node icons on the left side of the project workspace.

  

e) Record Levels
 

Select Record Levels to have the Speech Detection dialog will pop up after you select Go on the Build menu. You can change the recording lengths by selecting Project from the Menu bar, then clicking Recognition. 

 

 

f) Node Wizard
 

Select Node Wizard to display the Node Wizard dialog box while creating or debugging a project.

 

 

g) Inspect Recognition
 

Select Inspect Recognition to display the Inspect Recognition dialog box automatically when you simulate a project.

 

 

h) Node ID
 

Select Node ID to view the Node ID dialog box, listing all the project nodes, types, and ID numbers.


5. Project menu.

In the figure below, click a menu item to jump to the corresponding description about each feature available from the Project menu.
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a) Recognition
 

Select Recognition to set or change Automatic Speech Recognition (ASR) settings. See Recognition Parameters section for more information.

 

 

b) TTS Prompts
 

Select TTS Prompts to enter additional Text-To-Speech (TTS) prompts. See TTS Prompts section for more information.

  

c) Audio
 

Select Audio to set or change your project audio settings. See Audio Settings section for more information.

 

 d) Settings
 

Select Settings to set or change project settings. See Project Settings section for more information.


6. Build menu.
In the figure below, click a menu item to jump to the corresponding description. If you prefer, read through the entire section to learn about each feature available from Build.
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a) Build
 

Select Build to build the project. This will compile the project and inform you of any errors encountered. The project cannot be simulated without a successful build.

 

 b) Go
 

Select Go to start the simulation. You can also simulate using Step Into.

 

 c) Restart
 

Select Restart to cause the simulation to start over. This button is enabled only after simulation has begun.

 

 d) Stop
 

Select Stop to stop the simulation. You may have to wait while the operating system closes audio devices. This button is enabled only after simulation has begun. Upon stopping the simulation, the Node Wizard will appear if you have not deselected Node Wizard under the View menu.

  

e) Break Execution
 

Select Break Execution will pauses execution of the simulation.

 

 f) Step Into
 

Select Step Into to single step in a simulation. This will allow you to step through the simulation a node at a time.


7. Options menu.
In the figure below, click a menu item to jump to the corresponding description about each feature available from Options. 
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 a) Editor
 

Select Editor to set or change Editor option.

 

 

b) Build
 

Select Build to access the Build dialog box.


8. Window menu.

In the figure below, click a menu item to jump to the corresponding description. If you prefer, read through the entire section to learn about each feature available from Window.
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a) Cascade
 

Select Cascade to layer all opened project windows so that the title of each one is visible.

 

 

b) Tile
 

Select Tile to arrange all opened project on the same layer.

  

c) Current and previous projects
 

At the bottom of the Window menu, a list displays the current project on which you are working, as well as recent projects. The current project has a check mark next to it. You can open another project by selecting it from this list.


9. Help menu.

In the figure below, click a menu item to jump to the corresponding description. If you prefer, read through the entire section to learn about each feature available from Help. 
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 a) Contents
 

Select Contents to display the contents of the current help file.

 

 b) About Builder...
 

Select About Builder... to view the current copyright information and version number.


1. Toolbar.
The buttons on the Toolbar give you quick access to common application commands that you can also access from the Menu bar.
 

In the figure below, click an icon to jump to the corresponding description. If you prefer, read through the entire section to learn about the functionality of each feature.
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  a) New
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	Select New to create a new project.


  

b) Open
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	Click Open to retrieve an existing project. A dialog box will appear allowing you to browse for an existing project. Builder project files have an .fcb extension.


   

c) Save
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	Click Save to retain the changes you have made to the current project. This button will only be enabled when a change has been made.


  

 d) Print
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	Select Print in order to print the project workspace. A dialog box will open, allowing you to set printer properties and control which pages to print, how many copies to make, and whether to send the project to the printer or to a file.


  

 e) Cut
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	Click Cut to remove a selected node, link, or object from the project workspace and save it to the clipboard.


  

 f) Copy
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	Click Copy to duplicate a selected node, link, or object from the project workspace and save it to the clipboard. 


  

   

g) Paste
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	Choose Paste to insert the contents of the clipboard to the project workspace. This button is enabled only after something has been cut or copied. See Cut and Copy sections.


  

 h) Node Wizard
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	Select Node Wizard to display the Node Wizard dialog box while creating or debugging a project. See Node Wizard section for further explanation.


  

i) Toggle Grid
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	Toggle Grid turns the background grid on or off and causes nodes to be aligned to the grid dots. See Toggle Grid section for more information.


 

 j) Build
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	Click Build to build the project. This will compile the project and inform you of any errors encountered. The project cannot be simulated without a successful build.


  

k) Go
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	Select Go to start the simulation. You can also begin simulation using Step Into.


 

 l) Restart
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	Selecting Restart will cause the simulation to start over. This button is enabled only after simulation has begun.


 

 m) Stop Debugging
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	While simulating, you can stop the simulation if you choose Stop Debugging from the menu. You may have to wait while the system switches between input and output devices. Upon stopping the simulation, the Node Wizard will appear if you have not deselected Node Wizard under the View menu. This button is enabled only after simulation has started.


 

 n) Break Execution
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	Click Break Execution to stop or pauses execution in simulation. This button is enabled only after simulation has begun.


 

 o) Step Into
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	Select Step Into to step through a simulation one step at a time.


 

 p) Help Contents
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	If selected, Help Contents will display the first page of the Fonix Embedded Speech SDK help file.



1. Node palette.
Nodes are the basic building blocks for adding speech recognition and speech synthesis to an application. 

 

The Node Palette

To add a node to the project, click the node icon from the palette, then click anywhere in the project workspace. You can also add a node by clicking on a node icon and dragging it from the Node Palette to the desired position in the workspace.

 

Click an icon below for the corresponding description of that node.
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If you want to move the Node Palette to the Toolbar or another area on the screen, drag the Node Palette to the desired area.


2. Node types.

Nodes can be classified into two categories, recognition nodes and non-recognition nodes. This section describes the properties of each type of node and information about each node within the two types.

    

a) Non-Recognition nodes

Nodes of this type are the Beginning, Ending, and Junction nodes.

 

General properties:
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    One exit link, multiple entry links possible 

[image: image51.png]


    Allow TTS prompts and entry and exit commands
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    Execution order: entry command, TTS Prompt, exit command

 

Node specific properties:
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	Beginning
	One must exist to begin every project.

Multiples occurrences of the beginning node are not allowed.

No entry link.
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	Ending
	There can be none, one, or more per project.

No exit link.
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	Junction
	Use the Junction Node to connect multiple nodes on different branches, or to simply say a prompt based on recognition. See the example dialer.FCB for a look at how these nodes can be used.


   

b) Recognition nodes

Nodes of this type - Digit, Grammar, Keyword, WordSpotter

 

General properties:
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    Multiple entry links are possible.
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    Allows TTS prompt, entry and exit commands, and recognition.
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    Uses a general purpose or digit neural network.
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    Execution order: entry command, TTS Prompt, input data collection, recognition or an error message, exit command.
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	Keyword
	Does not time out on leading silence.

Can have multiple exit links.

Recognition-word-specific TTS prompt.

Each recognition word can have a prompt associated with the word. The prompt is played after recognition and before the exit command.

Maximum record is not begun until speech is detected.
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	WordSpotter
	Can have multiple exit links.

Recognition-word-specific TTS prompt.

each recognition word can have a prompt associated with the word. The prompt is played after recognition and before the exit command.

Maximum record is not begun until speech is detected.
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	Digit
	Uses a digit neural network specifically trained to recognize digits (0-9, + oh).

Only one link possible from it to one other node.

The grammar can be edited but no recognition words added.

The example dialer.FCB illustrates the use of Digit Nodes.
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	Grammar
	A Grammar Node can extract a series of words from a speech utterance according to the grammar rules that are defined. Before using this node, create a grammar as explained in Grammar Information section.

The Grammar Node can have only one link from it to another node.



3. Naming nodes.
This section explains how to change the names of the nodes in your project. 

 

How to name a node

The following steps apply to naming or renaming a node.

 

1 In the Fonix Embedded Builder project workspace, click the node name beneath the node. This will highlight the node name.

 

2 Type in the new name and click in the workspace, away from the node. The new name will be displayed underneath the node. When the node is selected, the new node name will appear in the Node Wizard dialog box.

 

The picture below shows a highlighted node name.
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4. Node ID.

The Node ID dialog box lists all the project nodes, types, and ID numbers. ID numbers are assigned as nodes are added to the project. If a node is removed, all IDs will be changed to keep IDs ascending with no gaps. You can not directly change an ID number.

 

For information on nodes, click a node icon in the picture below.
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1. Node Wizard.

Use the the Node Wizard to define node entry and exit commands, create prompts, add recognition words to a link, and set node specific ASR durations and rejection strength. See the Node Wizard tab pages (Node Links Commands ASR Durations) or click any tab in the picture below for more information:
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To display the Node Wizard dialog while creating or debugging a project, select View from the Menu bar, and then click Node Wizard. The dialog box disappears during simulation.


2. Node Wizard Nodes.

Use the Nodes tab to get node information, define Entry and Exit commands, and create prompts and error messages.

 

In the figure below, click the tabs or text to jump to the corresponding descriptions. If you prefer, read through the entire section to learn about each feature. 




 a) Node name

 

The Node name drop-down menu will display the name of a selected node. When open, the Node name drop-down menu displays the names of all the nodes in your project. Selecting a new name will highlight that connection and show its properties in the Node Wizard.

  

b) Node ID

 

The Node ID box displays the ID number assigned to the selected node. This number is assigned based on the order nodes are placed in your project. If a node is removed from the project, all nodes with higher ID numbers will be shifted to fill in the number that was removed.

 

 c) Rejection strength

 

Use the rejection strength to adjust the level of rejection during speech recognition for a specific node. The higher the setting the more certain the recognizer has to be of the speech to accept it as a word. The default is set to 60. This feature is enabled in Recognition nodes only.

  

d) Entry command
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The Entry command is the first event to occur when a node is executed. The functions that can be chosen from are defined on the Commands tab. The function you choose will show up in the Entry command drop-down menu. Place the function parameter inside the parenthesis within the function call.

 FnxSayTextPlusRecog and FnxSayRecogPlusText will not say anything as an Entry Command.

 

See Default Function Set for an explanation of the built-in functions.
 e) Exit command using recognition

 

[image: image68.png]Nodes | Links | Conmends | ASF Duaaions |

Hode name: NogelD: Refecton s
Keword 0 [
Erty command Exit command using ecogrilon:

[ Nare > =
Powpt (175} 3 (e,

FroPin e (Bozpll wav)

Ertor message: ]

FroE secute(Beepd. nav)
FroSayT enPlusRecag(Besplt
Fru ayFiecogPlusT en(Bezp0i





 

The Exit command is the last event to occur when a node is executed. The functions that can be chosen are defined on the Commands tab. Choose the function you want to assign to the selected node from the Exit command using recognition drop-down menu. Type the function parameter within the parenthesis of the function call. If no word was recognized, the Exit command will not be called

 

See Default Function Set section for an explanation of the built-in functions. 

 

 f) Prompt (TTS)

 

The Prompt (TTS) field is for any text you want said when the selected node executes. Type the prompt that you want to use for the selected node. The prompt will be spoken upon entry into the node after the Entry Command. Click the play button ([image: image69.png]


) next to Prompt (TTS) to hear your prompt.

  

g) Error Message

 

The Error message field is for entering a node specific error message that will play if the word or phrase spoken is not recognized. Click the play button ([image: image70.png]


) next to the words Error message to hear your error message. The default error message is set in the Audio dialog found in the Project menu. 


3. Node Wizard Links.
This section provides details about the Links tab functionality. It is important to remember that this tab performs different tasks for WordSpotter Nodes than it does for Grammar Nodes and Digit Nodes.

 

a) Links tab for Keyword and WordSpotter nodes

For Keyword and WordSpotter nodes, the Links tab allows you to add recognition words and prompts to a link in your project.

 

In the figure below, click the tabs or text to jump to the corresponding descriptions. If you prefer, read through the entire section to learn about each feature. 
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I) Node name
 

The Node Name drop-down menu will display the name of the node from which the selected link originates. When open, the Node name drop-down menu displays the names of all the nodes in your project. Selecting a new name will highlight that connection and show its properties in the Node Wizard.

  

II) Node connection
 

The Node connection field will display the name of the destination node of the link that is selected. The menu displays all of the connections for the source node. Selecting a new connection will highlight the new link and show its properties in the Node Wizard dialog box.

  

III) Recognition words
 

The Recognition Words area displays the recognition words associated with the link. The destination will be executed upon recognition of one of these words. Type one or more words for recognition under this column, making sure to only type one word or phrase per line.

 Fonix Fonix Embedded Speech SDK 2.0 supports special characters. For more information about the special characters, see Grammar Information, and Using Special Characters sections.
 IV) Phonemes
 

When a new recognition word is added, its corresponding phoneme will automatically appear in the Phonemes area. Use the phoneme area to check the phonetic spelling of each word. For optimum performance, avoid words with similar phonetic spelling within the same word set. The phoneme field is read only, changes made to these phonemes will not be saved. You may customize phonetic information using the Fonix ASR Dictionary Tool.

  

V) Prompts
 

Each recognition word may have a TTS prompt associated with the word. This phrase will be said when the word is recognized. This can be typed in or loaded from a file. You may edit the phrases or leave them blank.

  

VI) Load File
 

Click Load File to access an Open File dialog box from which you can select a text file. The program will load the contents of the file into the Links tab.

 

The program will load the contents of the file as recognition words with optional prompts. Each recognition word or phrase must be on its own line. Colons separate recognition words from prompts. Words that appear before a colon will load as recognition words. Words that appear after a colon will load as prompts. 

 

example text file

            quit : Goodbye

           exit : closing program

           leave

           stop : shutting down
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 VII) Display
 

At the bottom of the Links tab there are two Display choices: Phonemes and Prompts. Select Phonemes to display the phonemes for the recognition words. Select Prompts to display the prompts said after the word is recognized. 

 

 VIII) Play 
 

The play button ([image: image73.png]


) allows you to play the TTS of the recognition words or prompts. Place the cursor next to a recognition word or prompt, then click the play button to the right of the Display area. [image: image74.png]



 

	[image: image75.png]



	When using customized vocabulary, recognition words may not have been added to the dictionary and therefore may not play.


 

b) Adding recognition words

To add recognition words, follow these steps:

 

1) Select a node link.

 

2) Type or load one or more words for recognition under the Recognition Words column.

 

3) The recognition word becomes a hint if you have not deselected the Link hints option in the Editor Options dialog box.
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c) Links for Grammar and Digit nodes:

 For Grammar and Digit nodes, the Links tab allows you to add grammar specifications (specs) to a link. In this section, only the features unique to the Grammar Nodes and Digit Nodes are documented. In the figure below, click the tabs or text to jump to the corresponding descriptions.
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I) Grammar specs
 

In the Grammar specs field, type or load the grammar you wish to use. Digit Nodes have this box filled in automatically as in the picture above.

  

II) Load File
Click Load File to access an Open File dialog box from which you can select a text file. The program will load the contents of the file into the Links tab.

 

The program will load the contents of the file as recognition words with optional prompts. Each recognition word or phrase must be on its own line. Colons separate recognition words from prompts. Words that appear before a colon will load as recognition words. Words that appear after a colon will load as prompts. 

 

You can only load files for Grammar nodes.

 

 III) Word List
 

Click Word List to view the recognition word list and phonemes that are created for your grammar. Click this button again to return to the default view. The phoneme field is read only, any changes made to these phonemes will not be saved. You may customize phonetic information using the Fonix ASR Dictionary Tool.


4. Node Wizard Commands.
The Commands tab allows you to add functions to each node. Click the text, button, and tabs in the picture below to jump to the corresponding descriptions. If you prefer, read through the entire section to learn about each feature. 
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1 Command Name
 Command names identify the available functions. See Default Function Set below for an explanation of the included functions. See Nodes for information on Entry and Exit commands. You may add your own function to this list by simply typing the name of the function in the next available line. See User Defined Commands for information about creating functions.

 

 2 Use Defaults
 Click to return the command names to the default set.

 

 3 Default Function Set
 See Nodes for use of these built-in functions.

 

	Function
	Description

	FnxPrintText ( given text )
	Displays a Windows 32 message box with the given text.

	FnxPlayWave ( given wave file)
	Plays the given wave file.

	FnxExecute ( given executable )
	Runs the given executable under windows only. The executable can be anywhere on the machine's path.

	FnxSayTextPlusRecog ( given text )
	Says the given text then the recognized word.

	FnxSayRecogPlusText ( given text )
	Says the recognized word, then the given text.



5. Node Wizard ASR Durations.
The ASR Durations tab allows you to set automatic speech recognition parameters for individual recognition nodes. To adjust the node default settings, affecting all nodes created after the setting change, go to Project, and then select Recognition. 

 

Click the text and tabs in the picture below to jump to the corresponding descriptions. If you prefer, you can read a full description of ASR Durations in Recognition Parameters section.

 

The Use Defaults... button will assign the node defaults (set in Recognition Parameters) to an individual node.
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1. Grammar Information.

This section provides details about Grammar Nodes and grammar syntax. In addition to this, you will find steps that explain how to create grammar groupings and definitions.

 

a) Grammar node definition

A Grammar node can extract a series of words from a speech utterance, according to the set of rules that are defined by the grammar. The rules may dictate sequence, repetition, groupings, optional items, and Boolean expressions. Allowances can be made for the presence of noise and silence before and after words. Recognition words can be mapped to a value or word. 

 

Grammar nodes are helpful in places where combinations of words are desired. An example would be ordering a drink where you have combinations of size and type. A WordSpotter node could be used, but each combination of size and type would need to be entered as an individual recognition phrase. Grammars let you have words in between the words you are looking for. Grammars allow you to create complicated word combinations that would be almost impossible to create in a WordSpotter node. Grammars also allow you you say the recognition words as a sentence because words can be present in between the recognition words.

 

b) Grammar syntax definitions

Grammar syntax definitions are divided into six categories: Variables, Repetition, Grouping/Optional Items, Boolean, Output Directives, and Keywords. You will use these syntax definitions as you create a grammar.

 

 I) Variables 

Variables are used to name set of recognition words. You may create as many variables as desired. 

 

$ indicates the following word is a variable name (no space is allowed between $ and the word)

  

II) Repetition/Optional items

This category gives you the flexibility to allow optional variables or unlimited repetition of the same variable. 

[ ] encloses optional items. The enclosed items are not required for recognition to occur. If they occur, they can occur only once.

{} encloses items that may be repeated zero or more times. It differs from optional items because if they occur they can occur multiple times.

<> encloses items that are required once but may be repeated more times. The enclosed items must occur at least once.

  

III) Grouping

( ) encloses simple groupings. As in math equations, parentheses may be used to group items in grammars and word set to add clarity and readability. They are not required but may help in complicated grammars.

  

IV) Boolean

Boolean expressions are used to write how recognition words and variables relate to other words and variables inside variables and grammars.

Symbol Meaning

| OR

space/blank AND

 

 V) Output directives

These symbols allow you to map a recognition word to an output word. This is helpful when you are recognizing numbers and want to display the number as a series of digits. They can also be used if you want to represent a word with an abbreviation or another word.

 

Symbol Meaning

space/blank recognized word

% use will follow for external output 

%% no external output of word model 

 

Example:

                          Output

   two two

   two%2 2

   two%% 

  

VI) Keywords

There are three keywords which may not be redefined by the user. They can be thought of as predefined variables. Grammar is the only one where $ precedes the keyword.

Name Recognition Word / Input

sil silence

any noise and out of vocabulary words

grammar required variable name of the grammar

 

c) Creating a Grammar

Creating a grammar can be related to solving a story problem. Below is an example for creating a grammar for a pizza ordering system. For simplicity, we will assume that this pizza shop offers three sizes, two types of crust, and four toppings. We want the system to allow them to order up to five of the same pizza. The first step is to determine what words are used to describe the options and group them into types. From this, we will create word sets and assign each set a variable name.

 

This pizza shop calls their three sizes small, medium, and large. The crusts are thin and pan. The toppings offered are cheese, pepperoni, sausage, and ham. Our word sets would then look like:

[image: image80.png]


    Size set - small, medium, large

[image: image81.png]


    Crust set - thin, pan
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    Topping set - cheese, pepperoni, sausage, ham

[image: image83.png]


    Number set - one two three four five

  

I) Creating and naming word sets

   

Once you have determined what words need to be in your word sets, you are ready to name them and formally create them. To create a word set, you must assign each set a name, define how the words in the set are used, and define the output for each word in the set.

 

i) Create a word set by listing the recognition words for the set. A variable name is assigned by placing '=' between the name and the recognition words. The variable name must be preceded by a '$' character. The end of each set must be terminated a ';' character.

                 $size = small medium large;

                 $crust = thin pan;

                 $topping = cheese pepperoni sausage ham;

                 $number = one two three four five;

   

ii) The relationship between the words in the group must be expressed in terms of Boolean relationships. The Boolean characters defined above are used if each word in the set may be recognized 

                 $size = small | medium | large;

                 $crust = thin | pan;

                 $topping = cheese | pepperoni | sausage | ham;

                 $number = one | two | three | four | five;

   

iii) As the sets are currently written, the output for each recognition word would be the same as the recognition word. So if you said "three," the recognized word output would be "three." Each word may be mapped to a different representation of the word. Below, the sizes have been mapped to the standard one character representation and the numbers to digits. The same could be done to rest of the word sets.

                 $size = small%S | medium%M | large%L;

                 $crust = thin | pan;

                 $topping = cheese | pepperoni | sausage | ham;

                 $number = one%1 | two%2 | three%3 | four%4 | five%5;

  

II) Creating the grammar sequence

 

In our example, five word sets are now created and can be used in the sequence of the grammar. 

   

i) Create the sequence of each word set using the correct Boolean syntax. In the example of ordering pizza, people order by saying, "I would like one large thin crust pepperoni pizza with extra cheese." The sequence would look like:

                 $grammar = $number $size $crust $topping $topping.

 

ii) Allowing for recognition words that may not be said may be desired. Again in the example of ordering pizza, people may drop the "one," saying, "I would like a large thin crust pepperoni pizza with extra cheese." To allow for this, we change the sequence to:

                 $grammar = [$number] $size $crust $topping $topping.

 

iii) Define repeating patterns in grammar sequence. In our example, the number of toppings may vary from one to four. If we can change the sequence to accommodate this:

                 $grammar = [$number] $size $crust <$topping>.

We could place <> around the entire sequence to allow you to order multiple types of pizzas at one time.

  

iv) Recognition words may be added directly to the grammar sequence. The entire grammar may be written using no variables and only recognition words, but for large sets of recognition words, this would become complicated to read and edit. We may want to add optional silence between words to allow for pauses as the user thinks about what she wants.

                 $grammar = [$number] [sil%%] $size [sil%%] $crust <$topping>.

  

III) Combining the grammar sections

 

The complete grammar is defined by the variables and the grammar sequence. In a grammar node, all of these must be present for the grammar to work properly. The grammar may be written directly in the grammar specs window of the Link tab or loaded from a file. The pizza example would look like:

                 $size = small%S | medium%M | large%L;

                 $crust = thin | pan;

                 $topping = cheese | pepperoni | sausage | ham;

                 $number = one%1 | two%2 | three%3 | four%4 | five%5;

                 $grammar = [$number] $size $crust <$topping>.

 

Another example of a grammar is given here for recognizing multiple numbers between 0 - 99.

                 $zerodigit = zero%0 | oh%0; 

                 $digit = one%1 | two%2 | three%3 | four%4 | five%5 | six%6 | seven%7 | eight%8 | nine%9; 

                 $below20 = ten%10 | eleven%11 | twelve%12 | thirteen%13 | fourteen%14 | fifteen%15 | sixteen%16 | seventeen%17 | eighteen%18 | nineteen %19; 

                 $tens = twenty%20 | thirty%30 | forty%40 | fifty%50 | sixty%60 | seventy%70 | eighty%80 | ninety%90; 

                 $grammar = < (($zerodigit) | ($digit)) | ($below20) | ($tens[digit]) >;


1. Customizing TTS.

You can customize the way text is synthesized with the use of control tags. Control tags can be added to text to account for pausation, stress, and unique characters during synthesis.

 

a) Creating pausation for effect

To create pausation for effect, insert two, three, or four consecutive "greater than" marks between any two words in the text to be synthesized. Be sure to put a space before and after each group of "greater than" marks.

For a short pause, insert two "greater than" marks ( >> ). For a longer pause, insert three "greater than" marks ( >>> ). For the longest pause available, insert four "greater than" marks ( >>>> ).

 

Example: Creating pausation

To give emphasis to "deserve" in the sentence "You deserve a promotion," enter "You deserve >>> a promotion."

 

b) Altering stress in the text

To give special stress to words not ordinarily stressed, insert two left brackets into the text immediately after the word to be stressed. To take stress away from words ordinarily stressed, insert two right brackets into the text immediately after the word you want to de-emphasize. Be sure to put a space before and after each pair of brackets. 

 

Example: Altering stress

To stress the word "her" in the sentence "I want her to go now," enter "I want her [[ to go now."

To de-emphasize the word "go" in the sentence "I want her to go now," enter "I want her to go ]] now."

 

c) Using special characters

Fonix Embedded Speech SDK ASR supports native characters for U.S. English, U.K. English, and German. Characters are entered from a native keyboard or using their Alt-key combination code from a U.S. Keyboard.

 

Japanese is implemented using the Romanji character set. These are the same ASCII characters used in US English. Kanji, Hiragana, and Katakana are not supported.

 

Œ      alt-0140      German

œ      alt-0156      German

£      alt-0163      UK English

Ä      alt-0196      German

Å      alt-0197      German

Ö      alt-0214      German

Ü      alt-0220      German

ß      alt-0223      German

à      alt-0224      German

á      alt-0225      German

ä      alt-0228      German

è      alt-0232      German

é      alt-0233      German

ê      alt-0234      German

î      alt-0238      German

ñ      alt-0241      German

ö      alt-0246      German

ü      alt-0252      German


2. Testing.

After you complete your project, you may want to test it for any problems. This section provides specific information about how to locate and fix bugs. 

 

There are two ways to access the testing capabilities of the Fonix Embedded Builder: the Menu bar and the Toolbar. 

  

a) Testing with the Menu bar 

In order to test your project, go to Build within the Menu bar. Within Build, six menu items act as shortcuts to help you test your project.

 

          Build 

          Go 

           Restart

           Stop 

           Break Execution 

           Step Into 

  

b) Testing with the Toolbar 

You may choose to access the testing capabilities from the Toolbar instead of the Menu bar. Within the Toolbar, six icons act as shortcuts to help you test your project.

 

           [image: image84.png]
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 Break Execution
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 Step Into

1. Examples.

This section provides a link to the sample project that is included in the Fonix Embedded Speech SDK documentation. Information is also included to help you access the sample programs, and project files installed on the PC.

 

a) Building a Project

In Building a Project, you will learn how to create, build, and run a project. Step-by-step instructions also explain how to assign actions using the Node Wizard.

 

b) Sample programs

After you have installed Fonix Embedded, you can access the samples located in \fonix\sdk\embedded21\bin\builder. The following sample files are included:
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    DialerDemo.fcb
[image: image91.png]


    HelloDemo.fcb
 

c) User defined commands

Examples for creating your own enter and exit commands for a node can be found in User Defined Commands.

2. Revision history.

In this section, you will find the revision history for Fonix Embedded Speech SDK.  The most recent developments are listed first. 

 

a) What enhancements have been added to Fonix Embedded Speech SDK 2.0?
[image: image92.png]


    The product name Fonix Embedded and Fonix Embedded Builder has been changed to Fonix Embedded Speech SDK and Fonix Embedded Builder.

[image: image93.png]


    Encapsulated, single file, neural nets are used, providing enhanced ease of use, added security, and quicker initialization.

[image: image94.png]


    Recognition times have been improved by making incremental improvements in recognition procedures, including the following:

                             Faster FFT routines

                             Faster and less memory-demanding search graph routines

                             Increased frame rate

                             Active percent adjustments

[image: image95.png]


    The API deliverables have been componentized along functional lines to eliminate source duplication and to permit size-sensitive applications to build with the minimally-required components. The 2.0 release has the following deliverables: 

                             FonixAudioIn

                             FonixAudioOut

                             FonixCore

                             FonixAsr

                             FonixCommon

                             FonixL2WAsr

                             FonixSDAsr

                             FonixTTS

The various audio-in and audio-out APIs which were duplicated in some previous release APIs have been centralized in FonixAudioIn and FonixAudioOut.
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    Some calls have been changed or added to improve the integration of mixed mode ASR. These include:

                             FnxCoreGetUnrecognizedRawData

                             FnxCoreGetRawData.
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    The audio code has been modified to frame words more consistently, resulting in increased recognition accuracy. Additionally, the wave file audio code has been modified to process the wave data in exactly the same manner as data collected from live speech.
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    The “Optimize Word Search” or “Back Trace Heap” option and API has been eliminated since the new, faster, search graph eliminates the need for (and does not support) changing this parameter.
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    The speech detector code has been enhanced to track both silence and speech distributions, resulting in superior speech detection even with high, constant background noise. This enhanced “normal” speech detector is also much less prone to misfiring on background noise than the “high noise” speech detector. Therefore, the normal speech detector, with improvements, is used exclusively. An API call has been added to prime the speech detector with initial values in order to increase the accuracy of the very first word recognized (during which under normal circumstances, the speech detector adjusts automatically). For added flexibility, the API call also permits the user to freeze the speech detector thresholds.
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    To accommodate the needs of external developers creating audio drivers, code has been added to support the dynamic registration of third-party audio drivers (no Fonix library recompilation is required).
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    The speaker-dependent ASR APIs now support persistency and rejection.
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    Unlimited TTS APIs will be provided with support for the following languages: 

                             English

                             UK English

                             German.
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    Grammar handling has been enhanced to automatically insert optional silence between the “any” word designation, and and silence at the beginning and end of the grammar.

   

b) What enhancements were added to Fonix Embedded 1.1?
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    Platform-specific environment defaults
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    Multiple language ASR
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    Path control for Builder output
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    Ability to output a text file of all TTS strings

[image: image108.png]


    Ability to output a text file of all recognition node strings
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    Ability to output a text file of all node IDs in applet
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    Capability to create TTS prompts needed for user-defined functions
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    Application delay and build progress indicators
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    Improved user interface

3. Troubleshooting.
The following section describes several situations you may experience while using Fonix Embedded Speech SDK. Each issue appears in bold, with the corresponding solution below it. 

 

If you experience any difficulty when using Fonix Embedded Speech SDK, we want to help. In order to save time, please read through this section before contacting Fonix customer support about a particular issue. 

 

If you have a question about your platform, please see the platform-specific documentation.

 

 

1 When I build my project I get an error, but I cannot tell what is causing the error.
The Fonix Embedded Builder will highlight the node or link that is causing the error. Typically, an error in a link occurs if you fail to add a recognition word. Links from the WordSpotter or Keyword nodes must have at least one associated recognition word.

 

 

2 I installed Fonix Embedded Speech SDK on my computer and then decided I wanted it somewhere else. Since I moved the Fonix directory to this new location, I cannot get anything to work. 
Fonix Embedded Speech SDK has several environment variable settings that it relies on for proper operation. These environment variables are created or updated by the Fonix Embedded Speech SDK installer that you initially used. You must update these variables manually to make sure the paths are all correct. We recommend that you move the Fonix directory back to its original location, uninstall Fonix Embedded Speech SDK, and then install to the desired location.

 

 

3 I created a new project, but I cannot locate it.
New projects will be saved under the default Projects folder unless you specify otherwise in the Project Settings dialog. When you do a Save As, this directory will show up in the path. All example projects (with .fcb extension) will be located here.

 

 

4 When I double-click an .fcb project to open it from Windows Explorer, nothing happens.
You need to have the Fonix Embedded Builder open before you can open a project. Open the project from within the Fonix Embedded Builder by clicking File, then Open, or drag the example file from Explorer to the project workspace.

 

 

5 When the speech is played back, it is clipped or includes unwanted pauses.
The Fonix Embedded Builder offers a number of features to help you optimize and tune your application. Please read through the Recognition Parameters section for tips on how to adjust speed, noise, and accuracy.

 

 

6 I get an error message that says, "TTS Dictionary not found." 

This occurs when Customized Vocabulary TTS has been selected. The Customized Vocabulary TTS dictionary file must be located in the same directory as the output files for the Builder to find it. You can check this location in the Output directory field of the Project Settings dialog.

 

 

7 The leading silence bars increase to the end and the node repeats even when I am speaking into the microphone.
You need to make sure the Use wave files for node input box is not checked and the microphone is plugged in. Use wave files for node input is located on the Audio dialog of the Project menu.

 

 

8. Microphone data is recording, but no recognition is occurring.
Check the Replay speech input box to determine the quality of the speech input. If the input sounds extremely loud or clipped, try turning your microphone down or speak a little softer. Replay speech input is located on the Audio dialog of the Project menu.

 

 

9. I successfully built my project, but I can't find my output files.
The output files will be in the directory specified in the Output directory field of the Project Settings dialog. If they are not in that directory, make sure the output files you want to build are checked in the Build dialog of the Options menu.

 

 Contacting Fonix

Fonix provides numerous resources to help you as you develop applications with Fonix Embedded Speech SDK. In addition to the information provided at http://www.fonix.com, you can find solutions and ideas in the following ways.

 

1 Visit the Fonix support site at http://www.fonix.com/support to find upgrades, sample code, issue resolutions, and the latest product information. 

 2 Contact customer support directly by sending email to support@fonix.com.

4. Glossary.
This section defines related terms. The terms are organized alphabetically.

     

Automatic Speech Recognition (ASR)
Abbreviated ASR.  A computer program (or set of programs) with the ability to respond in a meaningful way to speech.  Possible responses derive meaning from the context and purpose of the program (or device) employing the technology:  in a dictation system, the appropriate response is to record the speech as text; in a voice-enabled database system, the appropriate response may be to look up the requested information and, by means of ASR, speak back the answer; and in a voice-enabled telephone system, it might be capable of connecting a caller to a particular phone as if the number had been dialed.  Several technologies exist to provide this capability, each with a set of properties that make it better suited for one purpose or another.  Unlike many other systems, Fonix ASR is speaker-independent and supports continuous, connected speech.  It is ideally suited for command-and-control applications. To learn more about the features of Fonix ASR, contact Fonix Sales at 1-801-55-FONIX (1-801-553-6649).

  

command (entry & exit)

A function that is called in a node. When used as an exit command the function is passed the recognized word or phrase.

  

concatenated speech

Sounds that are linked together in a series or chain to create speech.

 

 Customized Vocabulary TTS

A specific vocabulary of predefined words which are generated from cluster palettes. Each cluster palette contains all the pieces of sound for speaking the desired words. Customized Vocabulary compression techniques yield palettes with small footprints. This technology was developed to provide support for customer and application-specific needs. 

 

You can use Fonix Unlimited TTS to develop and prototype your application. Then, once you have refined the vocabulary used, Fonix will create a soundbank to fit your specifications. The Customized Vocabulary TTS built by Fonix can incorporate several languages, as well as male and female voices. Contact Fonix by calling 1-800-55-FONIX for more information.

  

discrete words

Discrete word recognition only allows the user to say one word at a time. The word to be recognized cannot be said in a sentence.

 

 embedded systems

Traditional software application that resides on a chip.  A stand-alone firmware solution, performing a specific task with minimal resource and power requirements, typically embedded in larger systems.  Any device smaller than a PC (personal computer) employing an electronic chip, such as a PDA (personal digital assistant). Typical processors:  DSP, RISC, Micro-controller, PowerPC.  Typical devices: hand-held calculator, smart cell phone, ABS (an automobile's Automatic Braking System), intelligent camera (photo apparatus).  Fonix sells Fonix Embedded Speech SDK to address this market.  For more information on Fonix Embedded Speech SDK, contact Fonix Sales at 1-801-55-FONIX (1-801-553-6649).

  

exit link

A link leaving a node.

  

entry link

A link leading to a node.

  

grammar

A set of rules that define the sequence, repetition, and grouping of recognition words. Allowances can be made for the presence of noise and silence before and after words.

  

letter-to-word ASR

Recognizes spoken letters which can then be compared to a given text file for possible word matches.

  

link

The line that connects two nodes. The properties of the link depend on the type of node from which it comes.

 

 neural net file

A file containing the parameters to recognize sounds for specific languages and tasks.

 

 node

A node is equivalent to a state in a finite statemachine. It has the ability to call commands and process TTS. Other functions depend on the type of node.

  

node default

Node settings are the default node settings until the settings are modified. Once modified, the new settings can be saved as new node defaults. Changing the node defaults will only change the default node settings of nodes created after the node default change. Changing the node default will not change nodes created prior to the default change. Existing nodes will maintain their settings. Node defaults are not global settings. They only affect future nodes, not existing nodes.

 

 out of vocabulary word

Any word that is not in the set of recognition words.

 

 phoneme

Phonemes are the individual consonant and vowel sounds that make up a language or the alphabet of spoken language. An example of a phoneme is the "p" sound in the words "pen" and "stop."  Discernible phonetic differences between specific sounds are primarily due to the phonological context, that is, the modifying influence of the adjacent sounds. It is commonly agreed that the dominant dialect of U.S. English employs roughly 40 phonemes.

  

platform

Can refer to an evaluation board with a Microcontroller/DSP or to just the Microcontroller/DSP.

  

recognition words

Recognition words are the words assigned for speech recognition by the project. See Node Wizard Links and Recognition Words for more information.

 

 rejection

The ability to reject a word that is not in the word set.

  

rejection strength

Indicates how accurate words must be for the recognizer to accept them as valid data. The default value is 60. Raising this value makes it harder to recognize words, increasing the number of words that get rejected. Lowering this value makes it easier to recognize words, but more likely that words outside the word set will be accepted. 

  

speaker-dependent recognition

A type of recognition which requires the user to train the recognition system in some form. After training, the speaker-dependent system is specific to that user. 

  

speaker-independent recognition

A type of recognition which does not require training. Any individual can use this system. 

  
speech detector

Used during the data collection process to find and mark the beginning and end of speech in the data.

  

Text-To-Speech (TTS)

A computer program (or set of programs) that takes machine-readable text as input and produces as digitized output which speaks the written text. Text-To-Speech includes neither the conversion of written text to machine-readable form, nor the synthesis of the digital representation of the sound to audible sound waves.  Other technologies handle these procedures.

 

 TTS prompt

Text spoken by the application to prompt a user when or what to speak.

 

 Unlimited Vocabulary TTS

The Fonix Unlimited Vocabulary TTS provides an infinite vocabulary of understandable speech output. This system uses speech clusters and the software means for concatenating them in desired words and phrases. The software allows for modifications to emphasis and pauses that provide correct meaning and context to spoken words and phrases. For information about customizing your TTS with modifications to emphasis and pauses see Customizing TTS.

 

If you are using the Fonix Embedded Builder, you will have access to the entire Unlimited Vocabulary. When you build a .dic file, Fonix Embedded Builder will analyze the application and include only the required speech content, making your specified vocabulary available for use on an embedded device.

 

 user commands

A command or function the programmer creates for use within the embedded project, as a node entry or exit command.

  

User vocabulary

In this process, the user's voice patterns for a specific word or phrase are stored. When the user speaks the word or phrase again, a match is made and the result is returned. This type of recognition allows a user to attach functionality to words of their choice.

  

voice verification

The matching of an individual's voice patterns for security purposes. Absolute identification must be made of an individual's voice patterns. 

  
word spotting

A type of recognition that allows the user to say a single word in a sentence. The recognition engine matches the word against the active word list and extracts the correct word. Fonix supports this model with speaker-independent recognition.

